Chapter 15, Monitoring, Managing, and Maintaining Network Resources
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Monitoring Access to Shared Folders

|2|
1.
Reasons for Monitoring Network Resources


A.
Maintenance


1.
Determine which users are currently using resources.


2.
Notify users before making a resource temporarily or permanently unavailable.


3.
Make certain resources unavailable to users when you perform maintenance tasks.


B.
Security


1.
Monitor user access to confidential resources.


2.
Verify that only authorized users are accessing certain resources.


C.
Planning


1.
Determine which resources are being used.


2.
Determine the extent to which resources are being accessed.


3.
Plan for future growth to meet the needs of the network users.
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2.
Requirements to Monitor Network Resources


A.
Not all users can monitor network resources.


B.
Members of the Domain Admins or Server Operators groups can monitor all computers in a domain.


C.
Members of the Administrators or Power Users groups can monitor local or remote computers in a workgroup.
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3.
Monitoring Shared Folders


A.
Use the Shares folder in the Shared Folders snap-in.


B.
View the following information:


1.
Shared Folder


a.
The shared folders on the computer


b.
This is the name given to the folder when it was shared.


2.
Shared Path: the path to the shared folder


3.
Type


a.
The type of network connection


b.
Examples: Microsoft Windows, Novell NetWare, or Apple Macintosh


4.
# Client Connections: the number of clients who have made a remote connection to the shared folder


5.
Comment


a.
Descriptive text about the folder


b.
This comment was provided when the folder was shared.


C.
Microsoft Windows XP Professional does not automatically update the list of shared folders, open files, and user sessions.


1.
To update the list, click Action.


2.
On the Action menu, click Refresh.


D.
Determining how many users can access a shared folder concurrently


1.
Click the shared folder in the details pane, and then on the Action menu, click Properties.


a.
The General tab shows you the user limit.


b.
In Windows XP Professional, the maximum is 10.


c.
You can set the limit to a lower value.


2.
If a user is having trouble connecting to a share, you can use the details pane to check if the maximum number of users has been reached.


E.
Modifying shared folder permissions


1.
Click the shared folder in the details pane.


2.
On the Action menu, click Properties, and then make any changes in the General and Security tabs.
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4.
Monitoring Open Files


A.
Use the Shares folder in the Shared Folders snap-in.


B.
View the following information:


1.
Open File: the name of the open file on the computer


2.
Accessed By: the logon name of the user who has the file open


3.
Type: the operating system running on the computer where the user is logged on


4.
# Locks


a.
The number of locks on the file


b.
Programs can request that the operating system lock a file to gain exclusive access and prevent other programs from making changes to the file.


5.
Open Mode


a.
The type of access that the user’s application requested when it opened the file


b.
Examples: Read or Write
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5.
Disconnecting Users from Open Files


A.
You can disconnect all users from all open files.


1.
In the Shared Folders snap-in console tree, click Open Files.


2.
On the Action menu, click Disconnect All Open Files.


B.
You can disconnect all users from one open file.


1.
In the Shared Folders snap-in console tree, click Open Files.


2.
In the details pane, select the open file.


3.
On the Action menu, click Close Open File.


C.
You should disconnect users from an open file before you make changes to the NT file system (NTFS) permissions on that file.


1.
The changes will not apply to any users with an open connection until they close and attempt to reconnect to the file.


2.
Disconnecting users from an open file can result in data loss.
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Creating and Sharing Local and Remote Folders
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1.
Creating and Sharing Local Folders


A.
Run the Create Shared Folder Wizard.


1.
In the console tree, under Shared Folders, click Shares.


2.
On the Action menu, click New File Share to start the Create Shared Folder Wizard.


a.
Create the folder before or while running the wizard.


b.
Specify the full path to the folder or browse for the folder in the wizard.


c.
Specify one of the basic share permissions.
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B.
Basic share permissions


1.
All Users Have Full Control: the Create Shared Folder Wizard assigns the Full Control share permission to the Everyone group


2.
Administrators Have Full Control; Other Users Have Read-Only Access


a.
The Create Shared Folder Wizard assigns the Full Control share permission to the Administrators group.


b.
The Create Shared Folder Wizard assigns the Read share permission to the Everyone group.


3.
Administrators Have Full Control; Other Users Have No Access


a.
The Create Shared Folder Wizard assigns the Full Control share permission to the Administrators group.


b.
The Create Shared Folder Wizard does not assign any other group or user share permissions.


4.
Customize Share And Folder Permissions


a.
Select this option to create your own custom share permissions and NTFS permissions.
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2.
Creating and Sharing Folders on a Remote Computer


A.
Create a custom MMC console.


1.
Add the Shared Folders snap-in.


2.
Point the snap-in to a remote computer.


3.
Run the Create Shared Folder Wizard.


B.
This is the only way to share a folder on a remote computer.


C.
You must create the same user account with the same password on each computer in the workgroup.


1.
In a workgroup, there is not a central database that contains all user accounts.


2.
Each computer in the workgroup has its own security database.
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Monitoring Network Users
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1.
Monitoring User Sessions


A.
Use the Sessions folder in the Shared Folders snap-in.


B.
View the following information:


1.
User: the users with a current network connection to this computer


2.
Computer: the Internet Protocol (IP) address of the user’s computer


3.
Type: the operating system running on the user’s computer


4.
# Open Files: the number of files that the user has open on this computer


5.
Connected Time: the time that has elapsed since the user established the current session


6.
Idle Time: the time that has elapsed since the user last accessed a resource on this computer


7.
Guest: whether this computer authenticated the user as a member of the built-in Guest account
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2.
Disconnecting Users


A.
You can disconnect one user or all users.


B.
You disconnect users to


1.
Make changes to shared folder and NTFS permissions effective immediately


a.
A user retains all permissions for a shared resource that Windows XP Professional assigned when the user connected to it.


b.
Windows XP Professional evaluates the permissions again the next time a connection is made.


2.
Free idle connections on a computer


a.
A user cannot make a connection when the maximum number of connections has been reached.


b.
User connections to resources might remain active for several minutes after a user finishes accessing a resource.


3.
Prepare a server so that you can shut it down


C.
Users can immediately make a new connection.


1.
If a user accesses a shared folder from a Windows–based client computer, the client computer automatically reestablishes the connection with the shared folder.


2.
Even if the user is not on a Windows–based client, the user can just make a new connection.


D.
You can prevent users from accessing the shared folder again.


1.
You can make changes to shared folder and NTFS permissions.


2.
You can stop sharing the folder to prevent all users from accessing the folder.
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3.
Sending Administrative Messages


A.
Notify users before you 


1.
Perform a backup or restore operation


2.
Disconnect users from a resource


3.
Upgrade software or hardware


4.
Shut down the computer


B.
Use the Shared Folders snap-in to send administrative messages.


1.
All currently connected computers appear in the list of recipients.


2.
You can add other users or computers to the list of recipients.
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Using Offline Folders and Files
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1.
Introducing Offline Folders and Files


A.
Use offline folders and files to continue working when


1.
The network is unavailable


2.
Your laptop is undocked


B.
The network files are cached on your local disk.


C.
This feature synchronizes the cached files and folders on your local disk with those on the network.
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2.
Configuring Your Computer to Use Offline Folders and Files


A.
Start Windows Explorer, and on the Tools menu, select Folder Options.


B.
Click the Offline Files tab, which has the following options:


1.
Enable Offline Files: configures your computer to use offline files


2.
Synchronize All Offline Files When Logging On


3.
Synchronize All Offline Files Before Logging Off


4.
Display A Reminder Every X Minutes


5.
Create An Offline Files Shortcut On The Desktop


6.
Encrypt Offline Files To Secure Data


7.
Amount Of Disk Space To Use For Temporary Offline Files


8.
Delete Files


a.
Delete Only The Temporary Offline Versions


b.
Delete Both The Temporary Offline Versions And The Versions That Are Always Available Offline


9.
View Files: displays the contents of the offline folder


10.
Advanced


a.
When A Network Connection Is Lost


(1)
Notify Me And Begin Working Offline


(2)
Never Allow My Computer To Go Offline


b.
Exception List: lists the computers you have exempted
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3.
Configuring Your Computer to Share Offline Folders and Files


A.
In Windows Explorer, right-click the folder, and then click Sharing And Security.


B.
In the Sharing tab, click Share This Folder.


C.
Click Caching and choose one of three settings:


1.
Manual Caching Of Documents (default)


a.
Users must manually specify any file that they want available when they are working offline.


b.
To ensure proper file sharing, the server version of the file is always open.


2.
Automatic Caching Of Documents


a.
Every file a user opens is automatically downloaded and cached on the user’s hard drive.


b.
If an earlier version of a file is already loaded on the user’s hard drive, it is automatically replaced with the newer version.


c.
To ensure proper file sharing, the server version of the file is always opened.


3.
Automatic Caching Of Programs and Documents


a.
Every file a user opens is automatically downloaded and cached on the user’s hard drive.


b.
If an earlier version of a file is already loaded on the user’s hard drive, it is automatically replaced with the newer version.


c.
File sharing is not ensured.
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4.
Synchronizing Files


A.
If the network version of a file does not change, your edited cached version updates the network version.


B.
If both the network version and your offline version change


1.
You can retain your edited cached version and not update the network version


2.
You can have the network version overwrite your edited cached version


3.
You can keep and rename your cached, edited version and keep a copy of both versions on your hard drive and on the network
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5.
Configuring Synchronization Manager


A.
Open Windows Explorer, and on the Tools menu, select Synchronize.


B.
Click Synchronize to manually synchronize your files with those on the network.


C.
Click Setup to configure the following options:


1.
The Logon/Logoff tab allows you to 


a.
Specify items to be synchronized when you log on or log off 


b.
Specify that you want to be prompted before synchronization occurs


2.
The On Idle tab provides the following options: 


a.
When I Am Using This Network Connection: allows you to specify the network connection


b.
Synchronize The Selected Items While My Computer Is Idle: allows you to specify the items to synchronize


c.
Advanced: allows you to


(1)
Specify the length of time your computer should be idle before the specified items should synchronize


(2)
Specify the frequency of synchronization while the computer continues to be idle


(3)
Prevent synchronization while the computer is running on battery power


3.
The Scheduled tab allows you to click Add to use the Scheduled Synchronization Wizard to select items to synchronize and then schedule the synchronization for a convenient time
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Using Scheduled Tasks
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1.
Introduction to Scheduled Tasks


A.
You can schedule a program, batch file, or script to automatically run 


1.
One time


2.
At regular intervals


3.
At specific times


4.
When certain operating system events occur


B.
You can use Scheduled Tasks to complete many administrative tasks for you.


C.
Scheduled tasks are saved in the Scheduled Tasks folder.


1.
To access the Scheduled Tasks folder on the local computer, click Start, click Control Panel, click Performance And Maintenance, and then click Scheduled Tasks.


2.
To access the Scheduled Tasks folder on a remote computer, browse that computer’s resources using My Network Places.
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2.
Configuring Options for Scheduled Tasks


A.
Application


1.
Select the applications to schedule.


2.
You can select from a list of applications that are registered with Windows XP Professional.


3.
You can click Browse to specify any program or batch file.


B.
Name: specify a descriptive name for the task


C.
Perform This Task


1.
Specify how often Windows XP Professional will perform the task.


2.
You can select daily, weekly, monthly, one time only, when the computer starts, or when you log on.


D.
Start Time: specify the start time for the task to occur


E.
Start Date: specify the start date for the task

F.
Name And Password

1.
Enter a user name and password.


2.
You can use your user name and password.


3.
You can use a different name and password


a.
If your user name does not have the required user rights to perform the scheduled task


b.
If you want to change to a lesser set of user rights


G.
Advanced Properties: displays the Advanced Properties dialog box
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3.
Setting Advanced Properties


A.
Task tab: allows you to change the scheduled task or user account that runs the task


1.
Run 


a.
You can type the path to the file you want to run as a scheduled task.


b.
If the task program requires parameters, type them after the task.


c.
If the path to the task program includes spaces, type double quotation marks around the entire task path.


2.
Start In


a.
You can specify the folder that contains the program files or related files.

b.
Sometimes programs require files from other locations and you can specify the other locations here.


3.
Comments: you can type a note or other information about the scheduled task.


4.
Run As: you can type the user account that runs the scheduled task.


5.
Set Password: you can click the Set Password button to specify the password for the user account.

6.
Enabled (Scheduled Task Runs At Specified Time) check box: you can select this check box to have the task run at the specified time.


B.
Schedule tab: allows you to set and display multiple schedules for the same task


1.
Schedule Task: you can schedule the task to run daily, weekly, monthly, one time only, when the computer starts, when you log on, or when the system is idle.


2.
Start Time: you can specify the time the scheduled task starts.


3.
Advanced button: displays the Advanced Schedule Options dialog box, in which you can specify the Start Date and the End Date and configure how often to Repeat Task.


4.
Show Multiple Schedules: select this check box if you want to configure multiple schedules for this task.


C.
Settings tab: sets options that affect when a task starts or stops


1.
Scheduled Task Completed


a.
Delete The Task If It Is Not Scheduled To Run Again check box


b.
Stop The Task If It Runs For X Hours X Minutes check box


2.
Idle Time


a.
Only Start The Task If The Computer Has Been Idle For At Least X Minutes check box and If The Computer Has Not Been Idle That Long, Retry For Up To X minutes check box


b.
Stop The Task If The Computer Ceases To Be Idle check box


3.
Power Management


a.
Don’t Start The Task If The Computer Is Running On Batteries 
check box


b.
Stop The Task If Battery Mode Begins check box


c.
Wake The Computer To Run This Task check box
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4.
Troubleshooting Scheduled Tasks


A.
You can check the parameters you have set up.


B.
The Advanced menu provides options to help you with troubleshooting.


1.
Stop Using Task Scheduler option or Start Using Task Scheduler option

a.
Verifies that the Task Scheduler Service is running

b.
If the Stop Using Task Scheduler option is displayed, the Task Scheduler Service is running.

c.
If the Task Scheduler Service is not running, the Start Using Task Scheduler option is displayed.

d.
Click the Start Using Task Scheduler option to start the Task Scheduler Service.

e.
Tasks will not start if the Task Scheduler Service is not running.

2.
Pause Task Scheduler option or Continue Task Scheduler option


a.
Verifies that the Task Scheduler Service is not paused

b.
If the Pause Task Scheduler option is displayed, the Task Scheduler Service is running.

c.
If the Continue Task Scheduler option is displayed, the Task Scheduler Service is paused.

d.
Click Continue Task Scheduler to resume running the Task Scheduler Service.


e.
Tasks will not start if the Task Scheduler Service is paused.


3.
Notify Me Of Missed Tasks option


a.
A check mark indicates that this option is selected.


b.
If you select this option, the system sends you a message when a scheduled task does not occur.


4.
AT Service Account option


a.
Allows you to change the account being used from the System account


b.
Displays the AT Service Account Configuration dialog box


5.
View Log option


a.
Allows you to view a log of when the Task Scheduler Service started, stopped, paused, and continued


b.
Logs the name of each scheduled task, the application or task that started, and the time and date the task was started
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1.
Starting Task Manager


A.
You can start Task Manager in one of three ways:


1.
Press Ctrl+Shift+Esc.


2.
Right-click the Taskbar, and then click Task Manager.


3.
Press Ctrl+Alt+Delete.

a.
In a domain environment, the Windows Security dialog box appears, and you must then click Task Manager.

b.
In a workgroup environment, depending on how the Logon and Logoff Options are configured, pressing Ctrl+Alt+Delete will either start the Task Manager or display the Windows Security dialog box (in which you click Task Manager).
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2.
Monitoring Programs


A.
Task Manager lists the applications that are currently running.

B.
To end a program, select the program, and then click End Task.


C.
To switch to a task, select the program, and then click Switch To.


D.
To start a new program, click New Task and in the Create New Task dialog box in the Open text box, type the path and filename of the program you would like to start, and then click OK.
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3.
Monitoring Processes


A.
The Processes tab in Task Manager lists the processes that are currently running.

B.
The Processes tab displays the following columns by default:


1.
Image Name–the name of the process


2.
User Name–the name of the user that the process is running under


3.
CPU–the percentage of time the threads of the process have used the processor since the last update


4.
Mem Usage–the amount of memory (in kilobytes) used by the process since it was started


C.
You can click Select Columns on the View menu to add other columns.


1.
PID (Process Identifier)–the numerical identifier assigned to the process while it is running


2.
CPU Time–the total processor time (in seconds) used by the process since it was started


3.
Base Priority–determines the order in which threads are scheduled for the processor. 


a.
The code, not the operating system, sets the base priority.


b.
To change the base priority, right-click the process, and then click Set Priority.


4.
I/O Read Bytes–the number of bytes transferred in input/output (I/O) operations generated by a process


5.
I/O Reads–the number of read I/O operations generated by a process


6.
I/O Write Bytes–the number of bytes written in I/O operations generated by a process


7.
I/O Writes–the number of write I/O operations generated by a process

8. Nonpaged Pool


a.
The amount of memory (in kilobytes) that is used by a process 


b.
Operating system memory that is never paged (moved from memory) to disk

9. Paged Pool


a.
The amount of system-allocated virtual memory (in kilobytes) used by a process


b.
Virtual memory that can be paged to disk


10.
Page Faults–the number of times that data had to be retrieved from the pagefile on the hard disk for this process because it had been paged out of physical memory


11.
Peak Memory Usage–the maximum amount of physical memory resident in a process since it started


12.
Thread Count–the number of threads running in a process
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4.
Monitoring System Performance


A.
The Performance tab in Task Manager shows a dynamic overview of system performance.


B.
The Performance tab displays the following fields by default:


1.
CPU Usage–the percentage of time that the processor is running a thread other than the idle thread


2.
CPU Usage History–the percentage of time that the processor is running a thread other than the idle thread shown over time


3.
PF Usage–the amount of virtual memory used (in kilobytes)


4.
Page File Usage History–the amount of virtual memory used (in kilobytes) shown over time


5.
Totals: Handles–the number of object handles in the tables of all processes


6.
Totals: Threads–the number of running threads including one idle thread per processor


7.
Totals: Processes–the number of active processes, including the idle process


8.
Physical Memory (K): Total–the amount of physical random access memory (RAM) installed in the computer


9.
Physical Memory (K): Available–the amount of physical memory available to processes


10.
Physical Memory (K): System Cache–the amount of physical memory released to the file cache on demand


11.
Commit Charge: Total–the size of virtual memory in use by all processes


12.
Commit Charge: Limit–the amount of virtual memory that can be committed to all processes without enlarging the paging file


13.
Commit Charge: Peak–the maximum amount of virtual memory used in the session


14.
Kernel Memory (K): Total–the sum of the paged and nonpaged memory


15.
Kernel Memory (K): Paged–the size of the paged pool allocated to the operating system


16.
Kernel Memory (K): Nonpaged–the size of the nonpaged pool allocated to the operating system
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5.
Monitoring Networking


A.
The Networking tab in Task Manager lists 


1.
The adapter name for each network adapter card


2.
The network utilization for each network adapter


3.
The link speed


4.
The state of the connection


B.
You can click Network Adapter History on the View menu to display 


1.
Bytes Sent and Bytes Received


2.
The default display of Bytes Total
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1.
Introduction to the Performance Console


A.
Windows XP Professional contains two tools for monitoring resource usage.


1.
The System Monitor snap-in is used to track system use and network throughput.


2.
The Performance Logs And Alerts snap-in is used to collect performance data from the local or a remote computer.


B.
Both the System Monitor snap-in and the Performance Logs And Alerts snap-in are contained in the Performance console.
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2.
Using System Monitor


A.
System Monitor allows you to collect real-time data about memory, disk, processor, network, and other activity on your computer or remote computers.


B.
You can view the data in a graph, a histogram, or a report.


1.
A histogram is a chart that consists of horizontal or vertical bars.


2.
In a histogram, the widths or heights of these bars represent the values of certain data.


C.
Monitor resources on your computer and overall system performance to


1.
Evaluate how well your system is currently performing


2.
Detect and eliminate bottlenecks to improve performance


3.
Look for trends to plan for future growth and upgrades


4.
Evaluate the effects of tuning and configuration changes on your system
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3.
Adding Objects and Counters


A.
To monitor resources, you must select an object and counters.


B.
The available objects include the following:


1.
Cache: used to monitor the file system cache used to buffer physical device data


2.
Memory: used to monitor the physical and virtual memory on the computer


3.
PhysicalDisk: used to monitor a hard disk as a whole


4.
Processor: used to monitor CPUs


C.
You can add counters to an object in System Monitor.


1.
To add multiple counters, hold down Ctrl and select individual counters from the list.


2.
To add multiple consecutive counters in the list, hold down Shift and click the first counter, and then click the last counter you want to add.
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D.
Some counters useful for evaluating system performance


1.
Under Processor, choose % Processor Time.


a.
Indicates the percentage of time that the processor spends executing 
a nonidle thread, which is the percentage of time that the process is active


b.
During some operations, this might reach 100 percent.


c.
Periods of 100 percent activity should occur only occasionally.


2.
Under Processor, choose Interrupts/Sec.


a.
Indicates the average number of hardware interrupts that the processor is receiving and servicing in each second

b. It does not include deferred procedure calls (DPCs).


(1)
DPCs are software interrupts or tasks that require immediate processing, causing other tasks to be handled at a lower priority.


c.
This counter value is an indicator of the activity of devices that generate interrupts, such as the system clock, mouse, network adapter cards, and other peripheral devices.


d.
If the Processor Time value is more than 90 percent and the Interrupts/Sec value is greater than 15 percent, this processor probably needs help handling the interrupt load.


3.
Under Processor, choose % DPC Time.


a.
Indicates how much time the processor spends processing DPCs


b.
DPCs represent further processing of client requests.


4.
Under System, choose Processor Queue Length.


a.
Indicates the number of threads in the processor queue


b.
There is a single queue for processor time, even on computers with multiple processors.

 
c.
A sustained processor queue of greater than two threads usually indicates that the processor is slowing down the overall system performance.
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4.
Using Performance Logs And Alerts


A.
You use Performance Logs And Alerts to record performance data and system alerts.


B.
You can automatically collect performance data from the local computer or from remote computers.


C.
You can do one of the following:


1.
View the logged data from System Monitor 


2.
Export it to a spreadsheet program or a database program such as structured query language (SQL)
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5.
Establishing a Baseline


A.
A baseline is a measurement derived from collecting data over an extended period of time.


B.
The data should 


1.
Reflect typical types of workloads and user connections


2.
Include any unusual activity that occurs


C.
Use the data to determine what acceptable performance on your system is. The data becomes the baseline.


D.
The baseline represents resource usage under normal conditions.


E.
Use the baseline to 


1.
Determine bottlenecks developing on your system 


2.
Watch for changes in usage patterns
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6.
Identifying Bottlenecks


A.
Deviations from your baseline are good indicators of performance problems.


B.
A bottleneck exists if a particular component’s limitation is slowing the entire system performance.
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7.
Guidelines for Resolving Bottlenecks


A.
Verify that your hardware and software configurations meet or exceed Microsoft’s recommendation for Windows XP Professional and the services you are running.


B.
Review the applications that you are running and ensure that the resources they require are available.


C.
Review network and disk utilization and other activities occurring at the times that you see increased resource utilization.


D.
Never make more than one change at a time when trying to resolve a bottleneck.


E.
Always repeat monitoring to verify that the change you made actually improved the situation.
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Chapter Summary

A.
Monitoring network resources helps you 


1.
Determine whether a network resource is still needed and is secure


2.
Plan for growth


B.
Use the Shared Folders snap-in or the Computer Management snap-in to


1.
Monitor access to network resources on local or remote computers 


2.
Create a shared folder on a remote computer


3.
Send administrative messages to one or more users or computers


4.
View and disconnect users of open files 
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C.
Offline files are network files that are cached on your local disk so that they are available even if the network is not.


D.
Use the Folders Options selection on the Tools menu of My Computer or Windows Explorer to configure your computer to use offline files.


E.
Use Synchronization Manager to configure synchronization of the offline files you are using and the copies on the server.
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F.
Use Scheduled Tasks to schedule programs to run 


1.
Once, or at regular intervals


2.
At specific times, or when certain operating system events occur


G.
Use Task Manager to monitor and manage applications, processes, memory, processor performance, and network usage.


H.
The System Monitor snap-in provides performance objects and counters that allow you to monitor the performance of 


1.
Your computer 


2.
Other computers on the network
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